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THE BASICS OF FLEXGUI

The basics of FlexGui

Please note: This chapter will present the basics of FlexGui. However, we recommend that
you first take a look at the FlexGui and FlexGui Toolbox Getting Started-document1 which
will give you a taste of how to use both FlexGui and FlexGui Toolbox.
When going through the Getting Started, you will interact with several elements that are
integral to creating FlexProjects (FlexGui projects). This chapter together with chapter 2
aims to give you more insight into what these elements are and how they relate to each
other.
A FlexProject is made up by three main elements:
• Fidgets
• FidgetContainers
• Screens

1.1

Fidget

Fidgets are FlexGui widgets. These are components of the user interface and have well
defined functions and/or purposes. One can differentiate between two types of fidgets;
• FlexGui’s built-in fidgets.
These are fidgets, that have no or just optional configuration only. These are available
from the Fidget Belt in FlexGui running on the FD11.
• FlexGui Toolbox fidgets.
While all fidgets mentioned above are available in FlexGui Toolbox, it also provides
additional lower level fidgets, which has to be configured and/or programmed.
Fidgets are customizable using FidgetVariables (section 2.2.2). In FlexGui Toolbox these
are accessible from the Properties window, and a limited selection are available in FlexGui
using the Property Belt. The FidgetVariables are also accessible using FG-SLIM and
JavaScript, and any changes are reflected immediately. For more information on this,
please refer to section 2.
Please see appendix E for an overview of all available Fidgets or visit the Fidget Reference Manual on the FlexGui Wiki at wiki.flexgui.net for descriptions of all fidgets and their
properties.

1.1.1

Handling

This section will describe what options are available for handling Fidgets in FlexGui and
FlexGui Toolbox.
FlexGui
In FlexGui on the Teach Pendant (TP), the options available depends on the specific fidget.
As explained in the Getting Started-guide, the Enable button on the TP-keyboard or the
Enable-button in the Screen Belt has to be held/activated for editing fidgets in FlexGui.
This is depicted in figure 1.

1

The Getting Started document can be found at www.flexgui.net

1.1
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Fidget

Figure 1: Moving a fidget in FlexGui.

When a fidget is moved, it will move according to a underlying grid to ease aligned placement of fidgets. In addition, fidgets can be deleted by dragging it to the Delete Belt on the
right, or its properties can be edited by dragging it to the Properties Belt on the left. Figure
2 shows the property editor for an IntDisplay Fidget.

1

2

Figure 2: Property Editor in FlexGui

Only a subset of a fidget’s properties are available from the Teach Pendant. A specific
property value can be manually edited by clicking the field as shown by 1 in figure 2, or
changed to an entry from the lookup table (see section 3) by clicking the dropdown-icon
shown by 2. For access to all properties, FlexGui Toolbox must be used.
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FlexGui Toolbox
FlexGui Toolbox is the development environment for FlexGui, and offers full editing options
of all built-in fidgets as well as lower level fidgets. To add a fidget, drag it from the Available
Fidgets-pane on the left hand side. An overview of all objects on a screen can be seen in
the Screen contents-pane.
The available handling options for fidgets are:
•
•
•
•

Moving
Aligning
Resizing
Order

In order to perform any of these actions on a Fidget, it has to be selected by clicking it. A
dashed bounding box shows the current selection.
Moving
Moving a fidget is done by clicking and dragging it around on the screen. It will move
according to a grid with 10 pixel intervals.
Moving fidgets can also be done by manipulating the left- and top-properties of the fidget,
as depicted in figure 3.
The left- and top-properties will always be relative to the upper left corner of a fidget’s
parent container. This means that if it is placed directly on the screen, it will be relative
to the screen, and if it is placed inside a Fidget Container, it will be relative to the Fidget
Container.
Aligning
There are several options available for aligning fidgets. Select the fidgets to be aligned,
right click and go to Align for all the alignment options. All alignment will be relative to the
last selected fidget, which is shown by a black dashed boundingbox, while the remaining
selected fidgets have gray dashed boundingboxes.
The options available are:
• Align to left
Align fidgets to the left edge of the last selected fidget
• Align to center
Align fidgets to the center (horizontal) of the last selected fidget
• Align to right
Align fidgets to the right edge of the last selected fidget
• Align to top
Align fidgets to the top edge of the last selected fidget
• Align to middle
Align fidgets to the middle (vertical) of the last selected fidget
• Align to bottom
Align fidgets to the bottom edge of the last selected fidget

1.1
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Resizing
The availability of resizing options depends on the fidget in question. Sizes of fidgets are
determined either by its height and width properties or by other properties.
• Fidgets with editable height and width properties
These fidgets can be resized by simply dragging its edges after they are selected or
by modifying their height and width properties in the properties pane on the right side
of the screen. An example of this is the AnalogueGauge-fidget.
• Fidgets with locked height and width properties
These fidgets can not be resized by dragging the mouse. Their size are often defined
as as a function of other properties. E.g. the TableDisplay -fidget’s size is determined
by the amount of rows and columns together with their cellWidth, cellHeight, cellSpacing and cellPadding.
Order
The order of fidgets can be set by right-clicking a fidget and going to Order. The available
options are:
• Bring to front
• Send to back

1.1.2

Editing Properties

As previously mentioned, the Teach Pendant has limited editing options for Fidgets’ properties, while FlexGui Toolbox has access to all properties.
For editing the attributes/properties of a Fidget, it has to be selected. Its properties will
be shown in the Properties pane located to the right in FlexGui Toolbox. The properties
of a Button Fidget is depicted in figure 3. The properties can also be programmatically
addressed as FidgetVariables, which will be presented in section 2.2.

Figure 3: Properties of a Button Fidget
The base properties of a Fidget is name, width/height and top/left, and is described in table
1. The remaining properties are dependent on which specific Fidget is edited.

1
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Description
Name of the Fidget
Height and width of the Fidget in pixels.
The horizontal and vertical position, in pixels, relative to the
top-left corner of its parent container (screen or fidgetcontainer ).
Table 1: Base properties of a Fidget

1.2

FidgetContainer

FidgetContainers can be used to group fidgets. If a FidgetContainer is moved, all fidgets
inside will move together with the container. FidgetVariable paths between fidgets inside
a container can be relative to the container. As will be explained in section 1.2.2, FidgetContainers can also be turned into project or global fidgets that are available from FlexGuis
FidgetBelt as droppable fidgets.
To create a FidgetContainer in FlexGui Toolbox, right-click on a screen and select "New
fidget container". Items can be added and removed from the container using drag and
drop.

Figure 4: Properties of a FidgetContainer
The properties seen in figure 4, are described in table 2.

1.2
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Property

Description

name

Name of the container

width/height

Height and width of the containers in pixels.

left/top

The horizontal and vertical position, in pixels, relative to the
top-left corner of its parent container (screen or another fidgetcontainer ).

caption

The caption displayed in FlexGui’s FidgetBelt if it is converted to a fidget.

fillmode

Fillmode if a background image is used. Available fillmodes
include: Stretch, PreserveAspectFit, PreserveAspectCrop,
Tile, TileVertically, TileHorizontally.

background

Background color

backgroundImage

Background image. Applied with with the selected fillmode.

help

Help text that is shown when hovering the mouse over a
Fidget in FlexGui Toolbox’s Global/Project Fidget menu and
when tap-and-holding a fidget in FlexGui’s FidgetBelt.

onLoad

Script for the onLoad-event.
Please see section 2 for more information

onFidgetVariableChanged

Script for the onFidgetVariableChanged-event.
Please see section 2 for more information

onRobotVariableChanged

Script for the onRobotVariableChanged-event.
Please see section 2 for more information

Table 2: Properties of a FidgetContainer

1.2.1

Handling

Handling of FidgetContainers is analogous to handling of Fidgets (see section 1.1.1). The
main difference is how the container will automatically expand to accommodate any added
fidgets as they are placed inside it. In addition, it features a shrink -function, which can be
accessed by right clicking the container. This will shrink the container to the minimal size
by removing excess space to the outer boundaries of the fidgets inside the fidgetcontainer.

1.2.2

Creating a Fidget from a FidgetContainer

A Fidget is created from a FidgetContainer by right-clicking the container and going to Make
template. The choices are:
• Global
The created fidget becomes available in FlexGui Toolbox’s Global Custom Fidgetspane regardless of which project is opened. No implication for FlexGui.
• Project
The created fidget becomes available in the Project Custom Fidgets-pane for the

1
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associated project in FlexGui Toolbox. It will also become available for uploading to
FlexGui using FlexProject Explorer, which is explained in section 4. When uploaded
to FlexGui, it will become a traditional droppable fidget located in the Fidget Belt.
Relative Paths
When creating a Fidget out of a FidgetContainer, the scripting has to be done using relative
paths to ensure that the resulting fidget works correctly.
Figure 5 shows the Screen contents-pane for a screen with a CheckBox and an IndicatorLamp placed inside a FidgetContainer. There are two ways a value of an object inside a
FidgetContainer can be obtained; using the absolute path or a relative path. When creating
Fidgets, relative paths has to be used. However, for understanding the difference, both are
explained.

Figure 5: Screen contents and FidgetContainer with a checkbox
Absolute Paths for the Fidgets

/TestScreen/FidgetContainer/CheckBox
/TestScreen/FidgetContainer/IndicatorLamp
The absolute paths can be obtained by right clicking the fidget in the Screen contents-pane
and selecting Copy Path.
Relative Paths for the Fidgets

CheckBox
IndicatorLamp

Please note: Relative paths does not start with /
In the examples above, the paths refers directly to the Fidget-objects. However, for manipulating a Fidget’s properties, the path has to be expanded with the property -name which
can be seen in the upcoming example.

1.3
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Example with relative paths in FidgetContainers:
Action:

Change the IndicatorLamp’s value-property to the value of the CheckBox’s checked property (see figure 5)

Topic(s):

· Using relative paths in FidgetContainers
· Using the onFidgetVariableChanged event.

Setup:

Add either the FG-SLIM or JavaScript version of the script in the onFidgetVariableChanged event by selecting the FidgetContainer and clicking the edit script-button

FG-SLIM
Code:

LETVS V" IndicatorLamp /value"$,V" CheckBox / checked "$

JavaScript
Code:

getFidgetVariable (" IndicatorLamp /value"). value =
getFidgetVariable (" CheckBox / checked "). value

Comments:

To create a Fidget of this, right click the FidgetContainer and choose
the desired type.
Please note: If absolute paths are used when creating Fidgets, they will
not function correctly, as they contain the Screen in the path. Consequently the paths will be incorrect unless they are placed on a screen
with this name.

More information about programming in FlexGui can be found in section 2. You may also
visit www.flexgui.net for additional documentation and examples.

1.3

Screen

A screen is a specialised FidgetContainer with expanded properties such as caption, hasScreenBelt, hasFidgetBelt and more. A screen therefore inherits most properties of a FidgetContainer, which is described in section 1.2. The properties of a screen can be found at
the righthand side in FlexGui Toolbox if the screen container is the selection as depicted in
figure 6.
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Figure 6: Properties of a screen
Property
caption
hasScreenBelt
hasFidgetBelt
listedOnBelt
isEditable

Description
The title of the screen, which is shown in the screen belt in FlexGui and
the screen-tabs in FlexGui Toolbox.
Determines if the screenbelt is available from the screen.
Determines if the fidgetbelt is available from the screen.
Determines if the screen should be shown on the screenbelt.
Determines if the screen is editable in FlexGui’s edit mode
Table 3: Special properties of a Screen

Additional functions for controlling screens programatically can be found in appendix A and
C for FG-SLIM and JavaScript, respectively.
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Programming

When programming for FlexGui, one can choose between two programming languages;
FG-SLIM and JavaScript. They can be used to program the behaviour of FlexGui’s basic
elements; Screens, FidgetContainers, Fidgets as well as Robot Variables. As seen in figure 7, the code is executed on specific events such as clicks or updates in either FlexGui’s
fidgets or NACHI’s robot variables.
NACHI Standard Control Interface
The traditional NACHI control system is
running like normal; controlling all MOVE
commands or any other application-related
commands.
Upon subscription, the control interface
supplies FlexGui with the requested variables
as well as executes any request made for
changing variables.
•
•
Robot Variables

FlexGui
FlexGui uses its internal Fidget Variables as
well as any received Robot Variables.
FG-SLIM or JavaScript is executed when specific events occur.
Fidget Variables
•
Robot Variables
Event
onLoad
onClicked
onFidgetVariableChanged
onRobotVariableChanged
Execute FG-SLIM or JavaScript
Result
Fidget Variables
Robot Variables

•

Figure 7: How FlexGui and NACHI’s standard control interface works together.
As the figure suggests, FidgetVariables, RobotVariables and FlexGui’s event handlers are
integral parts of how it operates. The upcoming sections will present more information on
these.
In practice, adding code to your FlexProject 1 is predominantly done using FlexGui Toolbox.
The events such as onLoad, onFidgetVariableChanged and onRobotVariableChanged are
programmable in FlexGui Toolbox by selecting a Screen or a FidgetContainer. To add code,
open the Script editor window as depicted in figure 8.

1

Term used for "FlexGui Projects"

2
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Click to edit script

Figure 8: onLoad, onFidgetVariableChanged and onRobotVariableChanged properties
when a Screen is selected.
When the script editor opens, the upper left of the window will show the language selector.
You must ensure that correct language is selected in order for the code to execute properly.

The event onClicked can be found for any button in FlexGui Toolbox, as depicted in figure
9.

Click to edit script

Figure 9: Enter onClicked editing script of a button.

2.1

What is FG-SLIM and JavaScript?

FG-SLIM is a programming language with a syntax that is similar to NACHI’s SLIM which
is familiar to many NACHI robot programmers. JavaScript is an interpreted programming
language with a syntax influenced by C, and has been used in many different applications
in computer programming.
When creating your FlexProject, the programming language to be used should be taken
into consideration. The FG-SLIM syntax is well known for NACHI robot programmers, and
it has a very compact syntax that is tailored for its original use. Therefore, previous experience with SLIM will enable you to proficiently program FlexGui with minimal additional
training. However, for programming advanced behaviours in FlexGui, JavaScript can offer
more power through its built-in functions such as; advanced string operations, array functions, math functions and RegEx.
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2.2

Variables

As these FG-SLIM and JavaScript differ both in functionality and how they interact with
variables, the upcoming sections will be presented with both languages.

2.2

Variables

There are two types of variables that are available in FlexGui:
• Robot Variables - Variables that NACHI’s standard control interface utilizes.
• Fidget Variables - FlexGui’s internal variables.

2.2.1

Robot Variables

The robot variables available to FlexGui are Integer, Real, String, Inputs/Outputs and Specials.
Integer variables
The integer has read and write access and are denoted by:
V[n]%, where n is 1..200, 301..500
Real variables
The real has read and write access and are denoted by:
V[n]!, where n is 1..200, 301..500
String variables
The string has read and write access and are denoted by:
V[n]$, where n is 1..50
Example that refers to an integer, a real and a string respectively: V12%, V33!, V2$
Inputs/Outputs
The input variables are read only, while the output variables have read and write access.
They are denoted by:
I[n], where n is 1..2048 for inputs.
O[n], where n is 1..2048 for outputs.
Special variables
In addition to the generic variables described above, FlexGui also has access to the robot
controllers special variables. These are variables such as the current program number,
selected speed, stepnumber etc. The special variables can be found in FlexGui Toolbox’
Variable Wizard, which is depicted in figure 10.

2
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Figure 10: The variable wizard
The variable wizard can be accessed by:
1. Clicking the Insert Variable-button in the lower left of a scripting window.
2. Clicking the
pane.

-icon to the right of a fidget’s text or value property in the Properties

Clicking one of the variables in the wizard, will insert the variablename where the textcursor
is positioned.
Accessing the generic Robot Variables from FG-SLIM and JavaScript
Before one can use a Robot Variable in FlexGui, it is important to understand that FlexGui’s
internal values of the Robot Variables are not synced to all of the controllers robot variables by default. This would result in a huge load on FlexGui. Instead, FlexGui utilises
subscriptions. Subscribing to a Robot Variable tells NACHI’s standard control interface that
FlexGui wants to monitor the specified Robot Variable. Therefore, if a Robot Variable is not
subscribed, FlexGui will not receive it.
Subscriptions are done automatically when a binding expression is used (see section 2.3),
but has to be done manually when a Robot Variable is addressed through code in the event
handlers. This can be seen in some of the examples in this section.
FG-SLIM and JavaScript are quite different when it comes to accessing and manipulating
variables. When addressing the generic integers, reals and strings variables in FG-SLIM,
both getting and casting to the expected type is included in the syntax. This means that
addressing e.g. V1% directly will get the variable and cast it as an integer.

2.2
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Example 1:
(FG-SLIM)

Show a popup message with the value of V1% by pressing a button.

Setup:

Add Code 1 to the onLoad-script of the Screen and add Code 2 to the
onClicked-script of a button

Code 1:

SUB V1%

Code 2:

PRINT V1%

Comments:

Code 1 in this example shows that we have to subscribe to V1% using
the SUB-command before we address it in the onClicked-code. Subscription to a given variable only has to be done once, which is why it is
placed in the Screen’s onLoad event.
Code 2 in this example shows the PRINT-command, which basically
tells FlexGui to create a popup with whatever follows.

For doing the same using JavaScript, the getRobotVariable()-accessor has to be used.
In addition, the type which you want to cast it to has to be specified using the following
methods:
• intValue
Returns the value of the variable as an integer.
Example using a RobotVariable:

getRobotVariable("V1%").intValue
Will return the value of the robot integer variable V1% as an integer.
• realValue
Returns the value of the variable as a real.
Example using a RobotVariable:

getRobotVariable("V1%").realValue
Will return the value of the robot integer variable V1% as a real.
• value
Returns the value of the variable as a string.
Example using a RobotVariable:

getRobotVariable("V1%").value
Will return the value of the robot integer variable V1% as a string.
The intValue and realValue methods also support direct incrementation and decrementation. e.g. getRobotVariable("V1%").intValue++ will increase V1% by one, and conversely −− will decrease V1% by one.
In addition to these methods, the accessor also has the subscribe() method, which subscribes to the variable addressed in the accessor. This can be seen in the JavaScript
version of Example 1:

2
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Example 1:
(JavaScript)

Show a popup message with the value of V1% by pressing a button.

Setup:

Add Code 1 to the onLoad-script of the Screen and add Code 2 to the
onClicked-script of a button

Code 1:

getRobotVariable("V1%").subscribe();

Code 2:

popupMessage(getRobotVariable("V1%").intValue);

Comments:

Code 2 in this example shows the popupMessage()-function, which
tells FlexGui to create a popup its arguments.

While Example 1 has only handled generic integers, the same principle is valid for the
generic reals and strings.
Accessing the I/O- and Special Robot Variables from FG-SLIM and JavaScript
The Input/Output variables as well as the Special Variables are accessed in FG-SLIM by
using their name together with the generic variables’ syntax for typecasting:
V"[name]"$, V"[name]"%, V"[name]"!
This means that for these variables, the previous popup message example becomes:
Example 2:
(FG-SLIM)

Show a popup message with the current ProgramNumber by pressing
a button.

Setup:

Add Code 1 to the onLoad-script of the Screen and add Code 2 to the
onClicked-script of a button

Code 1:

SUB "O1"
SUB "ProgramNumber"

Code 2:

PRINT "Output 1 is: "+V"O1"$+
" and the current program is: "+V"ProgramNumber"$

Comments:

The typecasting in Code 2 can also be applied to the generic variables. For example, V1! can be casted to an integer by referring to
it by V"V1!"%. This means that if V1!=3.2, then V"V1!"% = 3.
Code 2 also show simple concatenation of strings in FG-SLIM. Please
see the FG-SLIM reference in Appendix B for more examples of string
operations.

As typecasting always has to be done manually in JavaScript, addressing Special Variables
is completely analogous to in example 1:
Example 2:
(JavaScript)

Show a popup message with the current CheckSpeed by pressing a
button.

Setup:

Add Code 1 to the onLoad-script of the Screen and add Code 2 to the
onClicked-script of a button

2.2
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Code 1:

getRobotVariable("O1").subscribe();
getRobotVariable("CheckSpeed").subscribe();

Code 2:

popupMessage("Output 1 is: "+getRobotVariable("O1").value
+" and check speed is: "+getRobotVariable("CheckSpeed")
.value);

Comments:

All the traditional string operations can be performed using the normal
JavaScript syntax in FlexGui.

2.2.2

Fidget Variables

Fidget Variables are FlexGui’s own internal variables. In practice they are the properties of
Fidgets, FidgetContainers and Screens.
Accessing the Fidget Variables from FG-SLIM and JavaScript
Fidget Variables are accessed in FG-SLIM by using the variables’ path together with the
type-casting syntax:
V"[path]"$, V"[path]"%, V"[path]"!, where path is a relative or absolute path.
Example 3:
(FG-SLIM)

Manipulate a label’s text based on the value of Output 1 and Input 1.

Setup:

Add Code 1 to the onLoad-script of the Screen and add Code 2 to the
onRobotVariableChanged-script of the Screen.

Code 1:

SUB "O1"
SUB "I1"

Code 2:

IF (VPATH$ = "O1") OR (VPATH$ = "I1")
IF (V"O1"%=1) AND (V"I1"%=1)
LETVS V"/Screen1/Label/text"$, "Conveyor is moving"!
ELSE
LETVS V"/Screen1/Label/text"$, "Conveyor is stationary."
ENDIF
ENDIF

Comments:

In Code 2 there are several new things:
• Use of the onRobotVariableChanged-event, which executes
whenever a Robot Variable is changed.
• Use of the VPATH$-variable, which ensures better performance
by masking execution of the code to only execute whenever the
variables of interest are changed.
• Use of the LETVS-command, for manipulating string variables.
See Appendix A for all the available commands.
• Addressing a Fidget Variable.

Accessing Fidget Variables using JavaScript is analogous to accessing Robot Variables.
The only difference is that the getFidgetVariable()-accessor is used instead. The same
type conversion methods; intValue, realValue and value are available.

2
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This means that example 3 becomes:
Example 3:
(JavaScript)

Manipulate a label’s text based on the value of Output 1 and Input 1.

Setup:

Add Code 1 to the onLoad-script of the Screen and add Code 2 to the
onRobotVariableChanged-script of the Screen.

Code 1:

getRobotVariable("O1").subscribe();
getRobotVariable("I1").subscribe();

Code 2:

if (path == "O1"|| path == "I1") {
if (getRobotVariable("O1").value == "1"&&
getRobotVariable("I1").value == "1") {
getFidgetVariable("/Screen1/Label/text").value =
"Conveyor is moving!";
}
else {
getFidgetVariable("/Screen1/Label/text").value =
"Conveyor is stationary!";
}
}

Comments:

The main differences in the JavaScript implementation can be seen
in Code 2, where the path-variable is simply called path. In addition,
JavaScript writes to a variable directly using the accessor, and does
not need a specific command as in FG-SLIM.

JavaScripts getFidgetVariable-accessor also has an additional method; boundValue.
This method can be used when a Fidget Variable such as a Slider ’s value-property or ComboBox’s text-property has been bound to Robot Variable(s) using the binding syntax. If
only one Robot Variable is bound to the a Fidget Variable, the boundValue-method supports both read and write, while only read is available when multiple variables are bound.
The binding syntax will be further presented in the upcoming section 2.3.

2.3

Binding Syntax

In addition to coding events using FG-SLIM or JavaScript, one can bind logical and numeric
expressions to any fidget’s value- or text-property using the FG-SLIM syntax (see section
B). In a value-property such an expression is bound by inserting it directly, while in a textproperty it is bound by encapsulating it inside of { } to denote that its content is not plain text
as illustrated in figure 11.

2.4
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Figure 11: Illustration of binding expressions in value and text-properties
Any expression bound in these properties will be automatically subscribed and rendered at
the onRobotVariableChanged event.

2.4

Event Handlers

The Event Handlers enables code to be executed at specific events so that continuous
polling the variables for changes is not neccessary. There are three event in FlexGui, which
are available for Screens and FidgetContainers:
• onLoad
Executed after the screen is loaded.
• onFidgetVariableChanged(path)
Executed after a FidgetVariable is changed.
• onRobotVariableChanged(path)
Executed after a RobotVariable is changed.
In addition to these three main events, there are Fidget-specific events such as the buttons
onClicked-event.

2.4.1

onLoad

onLoad is a good place to store initialization data, or start subscriptions to Robot Variables.
Subscribing to a Robot Variable tells NACHI’s standard control interface that FlexGui wants
to monitor the Robot Variable. If a Robot Variable is not subscribed, FlexGui will not receive
it.
Subscriptions are done by:
FG-SLIM:

SUB [variable]

JavaScript:

getRobotVariable("[variable]").subscribe()

When a Robot Variable has been subscribed, the variable will be available in the globally,
and is therefore available from anywhere within FlexGui, and will trigger all onRobotVariableChanged-events.
Please Note: When binding variables directly to a Fidget’s property (section 2.3), subscription will be done automatically.

page 20 of 59

2.4.2

2

PROGRAMMING

onFidgetVariableChanged(path)

This code is executed after a FidgetVariable is changed, for example a Slider value. The
path is the path of the variable that triggered the event, (e.g.: /Slider/value)
The path should be used to streamline the code to only execute the portions of the code
relevant for the event. This is shown in the example in section 2.2.2.

2.4.3

onRobotVariableChanged(path)

This code is executed after a RobotVariable is changed. The path is the path of the variable
that triggered the event (e.g. V1%).
The path should be used to streamline the code to only execute the portions of the code
relevant for the event. This is shown in the example in section 2.2.2.

Need more programming help?
Please see appendix A, B, C and D for more on both FG-SLIM and JavaScript.
You may also visit wiki.flexgui.net for additional information, use-case examples and inspiration on how to program and use FlexGui.
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Lookup Table

FlexGui’s Lookup Table enables frequently used variables and expressions to be addressed
using predefined names. The lookup table is defined by lookup.ini, which must be placed
in FlexGui Toolbox’ root directory, and uploaded to the robot using the FlexProject Explorer
(see section 4). Below is an example of a lookup.ini, which features both logic and numeric
expressions using the FG-SLIM syntax.
Example: lookup.ini
# Comments s t a r t s w i t h #
# InputLookups

Conveyor =I1
# OutputLookup

Pneumatic Gripper =O1
# L o g i c examples

Input 1 AND 2=I1 AND I2
I5 Exclusive OR O5=O5 XOR I5
Output 5 AND NOT Input 5=O5 AND NOT I5
# Numeric e x p r e s s i o n

PercentProgress =100 * (( V22% − 1)+(V23% − 1))/(V14 %+ V15 %)
The left side of the expression defines the name of the entry, while the right side defines
the associated variable, logic or numeric expression.
When a Lookup Table is defined, it can be accessed both in FlexGui and FlexGui Toolbox.
In FlexGui, it can be accessed by clicking the dropdown-icon to the right of a fidget’s valueproperty, as depicted in figure 12.

Figure 12: Accessing lookup table in FlexGui

3
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In Toolbox, the lookup table is included in the Variable Wizard, as depicted in figure 13.

Figure 13: Accessing lookup table in FlexGui Toolbox
As previously mentioned, the variable wizard can be accessed by:
1. Clicking the Insert Variable-button in the lower left of a scripting window.
2. Clicking the
pane.

-icon to the right of a fidget’s text or value property in the Properties

Please note: If lookup.ini has been added or edited, FlexGui Toolbox and/or FlexGui has to
be restarted. In addition, one should ensure that both FlexGui Toolbox and FlexGui has the
same lookup.ini when creating projects that utilise it to avoid any unexpected behavior due
to missing entries on either side.
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File transfer, backup and deployment

This section will present FlexGui’s backup feature as well as the FlexProject Explorer. The
FlexProject Explorer enables instant file transfer to and from all FlexGui enabled robots as
well as deployment to multiple FlexGuis at the same time. FlexProject Explorer can transfer,
among others:
•
•
•
•

Screens
Fidgets
Programs
Miscellaneous logs and configuration files such as lookup.ini etc.

Please note: For these features to work, FlexGui has to be properly configured and connected to FlexGui Toolbox. See chapter 6 for more information on how to configure and
connect FlexGui and FlexGui Toolbox.

4.1

File transfer to/from single FlexGui

The FlexProject Explorer enables both uploading and downloading of files in single FlexGui
mode. It can be opened by clicking the
-icon. As shown in Figure 14, one has to ensure
that FlexGui toolbox is connected to a the FlexGui of intrest for single-mode to be available.

1. Ensure correct FlexGui is selected

2. Click to open FlexProject Explorer

Figure 14: Selecting FlexGui And opening FlexProject Explorer
Figure 15 shows an opened FlexProject Explorer, where the local contents of FlexGui Toolbox is displayed on the left and the contents of the connected FlexGui instance is displayed
on the right.
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Figure 15: FlexProject Explorer in Single FlexGui mode.
Files can be either uploaded to, or downloaded from FlexGui by drag and drop between the
views or using the < and > buttons. A prompt regarding overwriting will appear if the object
transferred is already present on the target.
The Misc-category of holds the configuration file and logs that can be downloaded to your
computer. If a transfer is initiated, you will be prompted to select the desired destination for
the files.

4.2

File transfer to multiple FlexGuis

The FlexProject Explorer also enables deployment of your project, fidgets and robot programs to multiple FlexGuis at the same time. In contrast to single-mode from section 4.1,
no specific FlexGui instance has to be connected. Consequently, only step 2 from figure 14
is neccessary.
After the FlexProject Explorer is opened, the Multiple FlexGuis-tab will display all FlexGuis
that are registered with FlexGui Toolbox as depicted in figure 16.

Figure 16: FlexProject Explorer in Multiple FlexGuis mode.
Files can be uploaded to selected FlexGuis by ticking the corresponding checkboxes and
utilizing drag and drop between the views or the > button. During upload, an progress bar
displaying the current progress will be shown as in figure 17.

4.3
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Figure 17: FlexProject Explorer processing.
Please note: In Multiple FlexGuis-mode, only uploading to FlexGui is possible.

4.3

File transfer to FD on Desk

The FlexProject Explorer also have a dedicated tab for facilitating development with FD on
Desk by giving you a fast and easy way for moving your robotprograms from your FlexProject to FD on Desk’s program folder.

Figure 18: FlexProject Explorer for transferring to FD on Desk.
Please note: The RobotProgramDir -entry in the Preferences1 has to be configured to point
to FDonDesk’s robot program folder. E.g. c:/FDonDesk/Nra2011/WORK/PROGRAM

4.4

Backup and restore

FlexGui Toolbox’s backup feature enables you to take backups of your FlexGui-enabled
robots over your network.
After connecting to a FlexGui, the backup and restore functions can be found in the Connection-menu, as depicted in figure 19.

1

Preferences can be found by going to Edit → Preferences in FlexGui Toolbox’ menubar.
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Figure 19: Backup and restore from FlexGui Toolbox
After performing a backup, you will be asked where the backup-file should be stored. The
backups are stored as image-files with the .flexGuiBackup-extension.
Please note: During backup or restore, we recommend to keep interactions with the robot
controller minimal. The files and folders that are included in a backup can be customised in
FlexGui’s config.ini (see section 6 and appendix F).
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Remote view and control

Please note: This feature requires a Remote Operation license, please visit www.flexgui.net
for more information.
Remote view and remote remote control are features of FlexGui Toolbox that enables the
integrator to provide remote assistance to connected users.
Assistance is available on several levels, depending on the control level.
In remote view:
• Getting a mirrored view of the assisted operator’s interface (both FlexGui and NRA)
• Sending text messages to the assisted operator.
• Sending suggested key-presses to the assisted operator.
In remote control:
•
•
•
•

Getting a mirrored view of the assisted operator’s interface (both FlexGui and NRA)
Ability to control the assisted operator’s interface1 .
Sending teach pendant key-presses2 .
Sending text messages.

Please note: For these features to work, FlexGui has to be properly configured and connected to FlexGui Toolbox. See chapter 6 for more information on how to configure and
connect FlexGui and FlexGui Toolbox.

5.1

Remote View

To start remote view, select desired FlexGui, and click the

icon as depicted in figure 20.

1. Ensure correct FlexGui is selected

2. Click to open Remote view

Figure 20: Starting remote view.
When remote view is started, FlexGui Toolbox automatically downloads the FlexGui’s FlexProject, and synchronises all variables. From this point forward, only key data is transmitted between FlexGui Toolbox and the client FlexGui, which results in very low bandwidth
requirements as well as low delay3 .
1

The assisted operator must manually acknowledge interactions that lead to changes in RobotVariables
Due to safety concerns, the jogging buttons can not be controlled.
3
Remote view of the traditional NACHI interface (NRA) might have higher bandwidth requirements.
2
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Figure 21: Remote view window
At this point, the remote view is a passive spectator of the connected FlexGui-enabled
robot. The only interactions allowed are sending messages or indicating keypresses using
the buttons at the top of the remote view window.
Figure 22 shows the result of sending a message using the Send Message-button.

Figure 22: Message sent from FlexGui Toolbox.

The Send Keypress-button opens an interface as depicted in figure 23. The usage scenario
for this is to assist the robot operator by indicating which buttons to press. Indication-circles
will appear when you click on the virtual keypad, and the view will be reflected on FlexGui
running on the teach-pendant. Hold shift on the keyboard while clicking to show a key
combination where the enable-button must be held.

5.2
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Figure 23: Sending Keypress - Result of shift plus click on Z+

5.2

Remote Control

Remote control of the connected FlexGui is enabled by clicking the Request control-button.
The connected FlexGui client must then accept the request as depicted in figure 24.

Figure 24: Granting access for remote control

In this mode, the client FlexGui becomes a passive spectator while the integrator can
change screens and fidgets as well as add, edit or delete them. For editing the screens
in remote control, one can either toggle the Enable-button in the lower left corner of the
window or hold the Shift-key on the computer keyboard.
When interacting with FlexGui screens, actions that results in changes to robot variables
are not permitted in remote control-mode by default. To allow this, the operator present at
the robot’s location has to hold the Dead man’s switch1 on the teach pendant.
Other notable changes when in control-mode includes:

1
2

Green button located in the upper left of the teach pendant’s keyboard
Due to safety concerns, the jogging buttons can not be controlled.

5
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• The Send Keypress-button,
than just indicating them2 .

REMOTE VIEW AND CONTROL

, will now sends the keypress to the controller, rather

, becomes available as depicted figure 25, giving easy
• The NRA Switch-button,
access to switching back and forth between FlexGui and NACHI’s traditional interface.

Figure 25: Remote view window in with control granted
When controlling in NRA-view (depicted in figure 26), shortcuts that would normally require
holding the Enable-button can be accessed by holding the Shift-key on the keyboard.

Figure 26: Remote view of NACHI’s traditional interface
The control can be terminated by both sides by clicking/tapping their respective Terminatebuttons.
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This chapter will present the most important parts of configuring your FlexGui and FlexGui
Toolbox. The most essential part is the local setup between FlexGui on your robot(s) and a
computer running FlexGui Toolbox (Toolbox). This enables easy uploading of FlexProjects,
robot programs and license as well as monitoring and control of your robot(s) from within
the local network of your plant or production floor. Such a setup can be seen in figure 27,
where the FlexGui-enabled robot is configured to connect to a Toolbox.

Figure 27: Minimal setup for development, monitoring and control.
Toolbox is FlexGui’s integrated development environment. In addition, it also doubles as a
FlexServer. A FlexServer is a server that FlexGuis and Toolboxes can connect. In practice,
this means that both the Toolbox in direct connection to the robot and any of its client
Toolboxes1 can be used for development and monitoring of the robot. The "server" Toolbox
will relay any of the client Toolboxes’ requests, as depicted in figure 28.

Figure 28: Multi-Toolbox setup.
This type of setup allows multiple people to access a pool of robots through a central server.
It can also be set up for remote development from anywhere in the world (see section 6.3).
The minimal setup of connecting a FlexGui to a FlexGui Toolbox involves configuration of
FlexGui on the robot, which will be presented in section 6.1. The multi-toolbox setup on the
other hand, is an extension of this setup that involves configuration of Toolbox (section 6.2).

1

Client Toolboxes needs proper credentials to be able to connect to a FlexServer/Toolbox.
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FlexGui Configuration

This section will present how to configure FlexGui to connect to a FlexGui Toolbox/FlexServer
as depicted in figure 27.
For this minimal setup, you will need to know:
1. The hostname or IP of your robot controller.
2. The hostname or IP of the computer you wish to run FlexGui Toolbox; either for
FlexGui development or as a FlexServer proxy.
1. Hostname or IP of the robot controller
We need to know the hostname/ip of the robot controller in order to access its configurationfile. Using the teach pendant, go to Constant Settings → Communication → Ethernet. Make
note of its hostname or IP and continue.
2. Hostname or IP of the computer
We need to know the hostname or IP of the computer in order to configure FlexGui to
connect to it. One possible procedure for finding a computers IP is:
1. On the keyboard: hold windows-key and press R.
2. In the Run-dialog, write: cmd followed by Enter on the keyboard
3. In the commandline, write: ipconfig followed by Enter on the keyboard
4. In the commandline, locate the information for the used Ethernet adapter and note its
IPv4 Address.
When you have noted your computers IP, you are ready to configure FlexGui.
Modifying FlexGui’s configuration file
FlexGui is configured by manually editing its config.ini, which is located in the /FlexGui/ folder when accessing the FD11-controller via FTP1 .
Open your favourite FTP client and connect to the robot controller by inserting the IP previously determined, and:
• Navigate to /FlexGui/ and open config.ini for editing.
• Change the FlexServerAddress-entry to the hostname or IP of the computer.
You should now have a setup as depicted in below.

While the FlexServerAddres-entry is the only entry that requires change for a default configuration, you may also update other entries such as e.g. FlexGuiName if you want. See
appendix F for a table with all available configuration entries. If the config.ini is deleted, a
new one with default settings will be automatically generated upon rebooting the controller.
1

File Transfer Protocol - There are many different FTP-clients available. Suggestions: FileZilla or WinSCP
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After you have done the desired changes to config.ini, the robot controller has to be restarted.
When it has rebooted, test the connection by starting FlexGui Toolbox on the computer and
go to the Connect-screen and tap connect in FlexGui on the teach pendant.

6.2

FlexGui Toolbox Configuration

When configuring FlexGui Toolbox, it can be divided into configuration related to the following:
1. FlexGui Toolbox as a FlexServer or client in a multi-toolbox setup as in figure 28.
2. Integrating with FD on Desk.
3. Configuration of FlexGui preview.

6.2.1

FlexGui Toolbox as a FlexServer or client

Configuring FlexGui Toolbox as a FlexServer for other FlexGui Toolboxes to connect, involves expanding your current setup from a minimal one. For example with the default
FlexServerPort from section 6.1, the structure becomes as depicted in figure 29.

Figure 29: Multi-Toolbox setup for development, monitoring and control.
For the remainder of this section, the server will refer to the FlexGui Toolbox in direct connection to the FlexGui-enabled robot(s), while the clients refers to any FlexGui Toolbox
configured to connect to the server.
Configuring the server
By default, the FlexGui Toolbox is running with as a local network only -server on port 16732
with a randomly generated password.
To change the FlexServers password or port used for accessing it, go to Connection →
Local server settings as depicted in figure 30.

6
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Click to open local server settings

Figure 30: Accessing FlexGui Toolbox’ local server settings.
As can be seen from figure 31, there are three entries that can be configure: Port, Password
and Enable global connections.

Figure 31: Local server settings dialog
The Port determines the port of the FlexServer. If you choose anything different than the
default of 16732, you will need to ensure that both the FlexServerPort entry in config.ini for
the robot (see section 6.1), and that any client toolbox is configured to connect to this port.
The Password is used by any client toolboxes when connecting to the server toolbox. Note:
For safety reasons, an empty password is not possible. In this case, FlexGui Toolbox will
create a random password.
The checkbox for Enable global connections determines wether or not the server toolbox
can be connected from outside your local network. Please see section 6.3 for more information on how your system can be set up for external access.
Optional:
You may also configure the shown name for the FlexServer by changing the ToolboxNameentry found in Edit → Preferences. This can be convenient in client Toolboxes for distinguishing different servers. For a client Toolbox, this name is shown in the lower right
connection status field.

6.2
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Configuring client toolboxes
When setting up client toolboxes, you’ll need to know the following:
• The server’s IP or hostname.
• The servers port (default is 16732).
• The servers password.
To configure a client toolbox, go to the remote server settings as depicted in figure 32.

Click to open settings

Figure 32: Accessing FlexGui Toolbox’ advanced remote server settings.
As can be seen from figure 33, there are fields for the aforementioned data. Fill them in and
click OK.

Figure 33: Settings for connecting to FlexServer
Your toolbox should now be able to connect to the server toolbox by going to Connection →
Connect to remote server in the menubar. When connected, the client Toolbox will show all
FlexGuis connected to the server Toolbox.

6
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Integrating FlexGui Toolbox with FD on Desk

With default settings, the only necessary configuration for enabling all base functionality of
FlexGui Toolbox, is related to integration with NACHI’s simulation software, FD on Desk.
The preferences can be found by going to Edit → Preferences.
Table 4 shows the two entries related to the integration with FD on Desk.
Entry
RobotProgramDir

Description
Used by the FD on Desk tab in FlexProject Explorer. This
should be configured to point to FDonDesk’s robot program
folder. E.g. c:/FDonDesk/Nra2011/WORK/PROGRAM
Used by the File → Start FD on Desk option. This should
be configured to point to FDonDesk’s NRA execute file. E.g.
c:/FDonDesk/Nra2011/NRA2011.exe

NRA2011ExePath

Table 4: FD on Desk configuration entries

When these entries has been configured, you will be able to:
• Start FD on Desk directly from FlexGui Toolbox through File → Start FD on Desk
• Move robot programs back and forth between your FlexProject and FD on Desk by
using the FD on Desk -tab in the FlexProject Explorer.
6.2.3

Configuration of FlexGui Toolbox’ preview

There are multiple additional entries in the Edit → Preferences-window than the ones presented by table 4. Some of these are used for storing your settings for various functions in
FlexGui Toolbox, such as the server settings performed in the previous subsections, chosen
language and more.
In addition to these, there are entries that relates to how the Preview-function in FlexGui
Toolbox behaves. By default, these settings are the same as for a standard configuration of
FlexGui. However, if the Toolbox is used to develop for a customized FlexGui, the following
entries can be configured for matching your preview environment with the real environment:
Entry

Description

BeltItemHeight

Used in preview mode: The height of the items on the belts.

PressAndHoldMode

Used in preview mode: If set to "True", screen changes will
need a longer press on the screen Belt.

ShowUtilityScreen

Used in preview mode: If set to "True", the utility screen is
listed on the screen belt.

ShowNewScreen

Used in preview mode: If set to "True", the new screen icon
is listed on the screen belt.

Table 5: FlexGui Toolbox preview configuration entries

Please see appendix G for a table with descriptions for all available configuration entries.

6.3
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Please note: All changes done will be saved to "%localappdata%\PPM\FlexGuiToolbox\config.ini".
FlexGui Toolbox can therefore also be configured by editing this file. Performing configuration by manually editing the config.ini requires a restart of FlexGui Toolbox.
If the config.ini is deleted, a new one with default settings will be automatically generated
upon starting FlexGui Toolbox.

6.3

Setup for external access

This section will present several options for enabling development, control and monitoring
from outside your local network. The suggested setups differs depending on the following
factors:
• The existence or use of a local FlexGui Toolbox/FlexServer.
• If a VPN-tunnel is used for all external access to the network or not.
Please note: All the setups are illustrated with default ports.

6.3.1

FlexServer used as a proxy

This setup is a natural extension of the traditional multi-toolbox setup presented in section
6.2.1. The only differences is that the FlexServer has been configured so that it can be
accessed from the internet. An illustration of this setup can be seen in figure 34.

Figure 34: FlexServer used as a proxy
In this setup, it is worth to note that:
• FlexGui Toolbox on computer 1 must be configured to allow global connections.
• The router must be configured with port forwarding of 16732 to computer 1.
• RemoteViewHost on the client FlexGui Toolbox (computer 2), has to be configured to
the Public IP of the router.
This is the setup that we recommend for most cases, as it offers high flexibility where the
setup can be expanded for external access on-demand by simply checking a checkbox.
To enable global connections on the FlexServer, go to Connection → Local server settings,
and turn it on as depicted in figure 35

6
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Figure 35: Enabling global connections.
Please note: For security reasons, this checkbox will be deselected upon every restart of
FlexGui Toolbox.
On the client side, you have to ensure that the server address is the public IP or hostname
of the router. This is configured by going to Connection → Advanced remote server settings
and inserting it as illustrated in figure 36.

Figure 36: Settings for connecting to the FlexServer
6.3.2

Direct connection

In this setup, the robot connects directly to an external FlexGui Toolbox. This setup is only
intended to be used in small enterprises where the robot development is done only by an
external robot integrator. However, be aware of the limited flexibility of this solution.

This setup requires the following configuration:

6.3
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• FlexServerAddress set to the public IP or host associated with the receiving FlexGui
Toolbox.
• FD has direct internet access (no firewall blocking port 16732)
• The router in the receiving end has port 16732 forwarded to the computer running
FlexGui Toolbox.
As this setup uses the direct connection between FlexGui and FlexGui Toolbox, there is no
additional configuration needed in FlexGui Toolbox itself.

6.3.3

VPN-based setups

Many companies use VPN1 for external access to their internal network. As a VPN extends your local network, the setup of FlexGui and FlexGui Toolbox does not differ from the
setup on a traditional local network. Therefore, for a minimal setup as depicted in figure 37
becomes in practice the same as in section 6.1.

Figure 37: Minimal setup over VPN
Similarly, a setup allowing multiple toolboxes as depicted in figure 38 can be set up as
described in section 6.2.1.

Figure 38: Multi-Toolbox setup over VPN
Please note: Depending on the VPN-networks topology, you might need to check the Enable global connections option in Connection → Local server settings of the FlexServer
Toolbox.

1

VPN - Virtual Private Network

7
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Updating

FlexGui Toolbox can be considered the hub for managing your FlexGui enabled robots. This
also applies to updating, where FlexGui Toolbox updates FlexGui on the robot and verifies
its integrity.
Updates for FlexGui and FlexGui Toolbox are almost always in pairs. This is because
both the preview feature as well as the remote view feature of FlexGui Toolbox uses an
integrated version of FlexGui. As a result, it is recommended to update both the computers
with FlexGui Toolbox, and any FlexGui-enabled robot that these are used for.

7.1

Updating FlexGui Toolbox

For updating FlexGui Toolbox, go to Help → Check for updates as depicted in figure 39.

Figure 39: Check for updates in FlexGui Toolbox
If an update is available, you will be asked if you wish to download it. If confirmed, FlexGui
Toolbox will download an installer for the newest version.
Depending on the permissions associated with your Windows user account, the installer will
either start the updating progress automatically, or will prompt you that you have insufficient
permissions. If this is the case, a folder with the installer will automatically be opened so
you can start the installer manually.
Please note: For the Check for updates-functionality to work, the computer running FlexGui
Toolbox needs an internet connection. If no internet connection is available, a installer of
the newest version of FlexGui Toolbox can be manually downloaded from flexgui.net

7.2
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Updating FlexGui

The primary method for updating FlexGui is to use FlexGui Toolbox. Therefore, FlexGui
has to be configured to connect to the FlexGui Toolbox used for the updating. For more
information on configuring FlexGui, see chapter 6.
The update procedure can be summarized by:
• Connect FlexGui to your FlexGui Toolbox by going to FlexGui’s Connect-screen and
tapping Connect.
• Select the appropriate FlexGui-instance in FlexGui Toolbox as depicted in figure 40.
• Goto Help → Update FlexGui

Ensure correct FlexGui is selected

Figure 40: Select appropriate FlexGui
The procedure will start by giving you an update confirmation prompt as depicted in figure
41.

Figure 41: Confirm updating
When updating starts, the update window will display what is being done. It will query a file
check and update any file that needs updating as depicted in figure 42

7
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Figure 42: Confirm updating
When the update is finished, the dialog says that the update process finished successfully.
As depicted in figure 43.

Figure 43: Confirm updating

7.3

Manual update

As explained by the dialog depicted in figure 41, if the process is interrupted in any way
(loss of network connection etc.), the update may have to be done manually using FTP.
1. Start your FD11 controller and ensure that FlexGui is not running using the application
launcher.
2. Connecting to the FD11 controller via FTP.
3. On the FTP: Navigate to /FlexGui/Bin/
4. Copy all .dll files except FlexGuiToolbox.exe from the FlexGui Toolbox folder to the
FTP. (Default Toolbox install directory is: /Program files/PPM AS/FlexGui Toolbox/)
5. Powercycle your FD11 controller.
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Appendix - FG-SLIM Command list

The FG-SLIM command list is sorted alphabetically.
Command

Description

ADDVI

Adds an integer value to an integer variable.

ELSE

Optional branch for IF statements. This branch is executed if no other
branch was executable. If a branch of an IF statement is executed, no
other branches are executed after.

ELSEIF

Optional branch for IF statements that allows the usage of additional
conditions. If a branch of an IF statement is executed, no other
branches are executed after.

ENDIF

The closing statement of the IF statement.

ENDW

The closing statement of the WHILE statement.

FOR

This statement sets the cycle variable to the starting value, then runs its
main branch until the cycle variable is less then specified incrementing
it in every cycle.

IF

A conditional statement that runs its main branch if the condition is true
or another branch if there is any suitable. Only one branch runs all the
time, others are ignored.

LETVF

Sets the real variable specified to a new value.

LETVI

Sets the integer variable specified to a new value.

LETVS

Sets the string variable specified to a new value.

NEXT

The closing statement of the FOR statement.

PRINT

Prints the specified value to the user through a popup message.

RESET

Resets the output signal specified, setting its value to false.

SET

Sets the output signal specified, setting its value to true.

SETSCREEN

Sets the current screen to the one specified.

SUB

Subscribes to the variable specified.

UNSUB

Unsubscribes the variable specified.

WHILE

This statement runs its main branch while the condition is true.

A
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Detailed Description
Each command is presented with a short description, its parameters and a usage example.
Command:

ADDVI

Description:

Adds an integer value to an integer variable.

Parameters:

1. The variable to set. It can be the number of the variable or a variable.
2. The value to add to the original value.

Example:

ADDVI 1, 3
ADDVI V2%, (3+ V4 %) * 2

Command:

ELSE

Description:

Optional branch for IF statements. This branch is executed if no other
branch was executable. If a branch of an IF statement is executed, no
other branches are executed after.

Parameters:

No Parameters.

Example:

IF (V1%<0)
PRINT "V1% is less than 0"
ELSEIF (V1 % <10)
PRINT "V1% is less than 10"
ELSE
PRINT "V1% is not less than 10"
ENDIF
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Command:

ELSEIF

Description:

Optional branch for IF statements that allows the usage of additional
conditions. If a branch of an IF statement is executed, no other
branches are executed after.

Parameters:

1. Conditional expression. If true, the branch is executed, else it is
skipped.

Example:

IF (V1%<0)
PRINT "V1% is less than 0"
ELSEIF (V1 % <10)
PRINT "V1% is less than 10"
ELSE
PRINT "V1% is not less than 10"
ENDIF

Command:

ENDIF

Description:

The closing statement of the IF statement.

Parameters:

No parameters.

Example:

IF (V1%<0)
PRINT "V1% is less than 0"
ENDIF

Command:

ENDW

Description:

The closing statement of the WHILE statement.

Parameters:

No parameters.

Example:

LETVI V1%, 0
WHILE (V1 % <10)
PRINT V1%
ADDVI V1%, 1
ENDW

A
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Command:

FOR

Description:

This statement sets the cycle variable to the starting value, then runs its
main branch until the cycle variable is less then specified incrementing
it in every cycle.

Parameters:

1.
2.
3.
4.

Example:

FOR V1 %=0 TO 10 STEP 2
PRINT V1%
NEXT

Command:

IF

Description:

A conditional statement that runs its main branch if the condition is true
or another branch if there is any suitable. Only one branch runs all the
time, others are ignored.

Parameters:

1. Conditional expression. If true, the branch is executed, else it is
skipped.

Example:

IF (V1%<0)
PRINT "V1% is less than 0"
ENDIF

Command:

LETVF

Description:

Sets the real variable specified to a new value.

Parameters:

1. The variable to set. It can be the number of the variable or a variable.
2. The value to set.

Example:

LETVF 3, 10.4
LETVF V10!, V1 % * V3 !/2
LETVF "/ Screen1 / ProgressBar /value", V2 %+5

Cycle variable. The integer variable to use for incrementation.
Starting value. The value of the variable in the first cycle.
Final value. The value which is the maximum of the cycle variable.
Increment value. The value which is added to the cycle variable in
every cycle.
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Command:

LETVI

Description:

Sets the integer variable specified to a new value.

Parameters:

1. The variable to set. It can be the number of the variable or a variable.
2. The value to set.

Example:

LETVI 1, 3
LETVI V2%, V1 % * 2
LETVI V"/ Screen1 / ProgressBar /value"%, V2%
LETVI "/ Screen1 / ProgressBar /value", V"/ Screen1 /Sli
der/value"%

Command:

LETVS

Description:

Sets the string variable specified to a new value.

Parameters:

1. The variable to set. It can be the number of the variable or a variable.
2. The value to set.

Example:

LETVS 1, "New value"
LETVS V2$ , V5 % * V6%
LETVS "/ Screen1 /Label/text", " Something "

Command:

NEXT

Description:

The closing statement of the FOR statement.

Parameters:

No parameters.

Example:

FOR V1 %=0 TO 10 STEP 2
PRINT V1%
NEXT

A
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Command:

PRINT

Description:

Prints the specified value to the user through a popup message.

Parameters:

1. The value to print. This can be string, int or bool variable or constant

Example:

PRINT "Hello , user!"
PRINT V1 %+4
PRINT V"/ Screen1 / Slider /value"!/100

Command:

RESET

Description:

Resets the output signal specified, setting its value to false.

Parameters:

1. The number of the output signal to reset. This can be an integer
constant or variable.

Example:

RESET 1
RESET V1%

Command:

SET

Description:

Sets the output signal specified, setting its value to true.

Parameters:

1. The number of the output signal to set. This can be an integer constant or variable.

Example:

SET 1
SET V1 %+4

Command:

SETSCREEN

Description:

Sets the current screen to the one specified.

Parameters:

1. The name of the target screen. This can be a string constant or
variable.

Example:

SETSCREEN " Welcome "
LETVS 1, " Utility "
SETSCREEN V1$
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Command:

SUB

Description:

Subscribes to the variable specified.

Parameters:

1. The variable to subscribe to. Can be integer, real or string variable.

Example:

SUB V1%
SUB V21$

Command:

UNSUB

Description:

Unsubscribes the variable specified.

Parameters:

1. The variable to unsubscribe. Can be integer, real or string variable.

Example:

UNSUB V1%
UNSUB V21$

Command:

WHILE

Description:

This statement runs its main branch while the condition is true.

Parameters:

1. Conditional expression. While true, the branch is executed.

Example:

LETVI V1%, 0
WHILE (V1 % <10)
PRINT V1%
ADDVI V1%, 1
ENDW
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Appendix - FG-SLIM Expressions

Numeric Expressions
The supported operators in FG-SLIM are as follows:
Addition +
Subtraction −
Multiplication *
Division /
Braces ()
Processing is done in the following order: (), * and /, + and − Supported types: integers
and reals.
Example of PRINT 3*(V1+2)! processing where we assume that V1! is 2.2:

PRINT 3 * (2.2+2)
PRINT 3 * 4.2
PRINT 12.6

Logical Expressions
The supported operators are:
Equal: =
Less: <
Less or equal: <=
More: >
More or equal: >=
Not equal: <>
And: AND
Not: NOT
Or: OR
Xor: XOR
Braces: ()
Supported comparisons:
• Real or integer compared with real or integer
• String compared to string,
• Boolean expression compared to boolean expression
Example of processing PRINT V1>V2% AND V1$=V2$!
..where we assume that V1! is 1.4, V2% is 3, V1$ is "a", V2$ is "b":

PRINT 1.4 >3 AND "a"="b"
PRINT false AND false
PRINT false
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String Expressions
Using the addition operator between any type and a string will result in a string expression.
Example of processing:
Statement: PRINT 3*(2+4)+"is the"+V1$+", "+(V1>=V2!)!
Assumptions: V1$ is " value", V1! is 1.1, V2! is 1.2:

1.
2.
3.
4.
5.
6.
7.

PRINT
PRINT
PRINT
PRINT
PRINT
PRINT
PRINT

3 * 6+ "is the"+V1$+", "+(V1!>=V2!)
18+"is the"+V1$+", "+(V1!>=V2!)
18+"is the"+V1$+", "+false
"18 is the"+V1$+", "+false
"18 is the value"+", "+false
"18 is the value , "+false
"18 is the value , false"

And lastly, executing the PRINT command renders a popupmessage as depicted in figure
44.

Figure 44: Popupmessage with the result.

C
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Appendix - JavaScript Function Reference

Screen and UI related functions
Function
Description

newScreen(void) : void

Function
Description

setScreen(string screen_name) : void

Function
Description

getScreen(void) : string

Function
Description

popupMessage(string message) : void

Function
Description

hide(void) : void

Adds a new screen to FlexGui.

Jumps to the given screen. If not available, utility screen is loaded.

Returns the name of the visible screen.

Displays a popup message in FlexGui with the message. The popup
message will disappear when the user presses Ok.

Hides FlexGui, and shows to NRA.

Variable Related Functions
Function
Description

Function
Description

getFidgetVariable(string variable_name) : Variable
Gets a FidgetVariable. All public functions of Variable can be used on
the returned object. All properties can be set and queried on the variable.

getRobotVariable(string variable_name) : Variable
Reads the variable from FlexGui cache.
For example: getRobotVariable("V1%").value = "5"
Use refreshRobotVariable("V1%") to perform a single refresh
of the value in the cache.
Use getRobotVariable("V1%").subscribe() to make it automatically updated or getRobotVariable("V1%").unSubscribe() to
stop automatic updating.

Function
Description

refreshRobotVariable(string variable_name) : void
Refresh the robot variable in FlexGui cache.
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JavaScript is used in FlexGui to specify behaviour on specific events like event handlers or
button presses. The following section will explain the basic supported language elements
through examples for easier understanding of the system.

Statements
JavaScript statements are separated by a semicolon (;). States are executed in the sequence they are written. Blocks in JavaScript are surrounded by curly brackets ({}). You
can use blocks if you want to group statements.
Example:

a =
c =
for
{
c
}

5;b = 6;
12;
(a = 5; a < 10; a++) / / E x p l a i n e d l a t e r
= a + 2;

Please Note: JavaScript is case sensitive, variable a and A are different variables, while
white space does not matter: a = 5; is the same as a=5;.

Comments
Comments can be placed in the code, just surround any text with /* and */. If you write
// anywhere in the code, the following characters are considered to be comments until the
end of the line.
Example:

a = 5; / / T h i s i s v a r i a b l e a
/* *************
T h i s i s a comment t h a t i s
going through m u l t i p l e l i n e s
************** */

b = 6;

Variables
Variables are present in JavaScript for storing data. Variable names can be letters, numbers
and underscores (_), but they can’t start with a number. The declaration of a variable
creates the variable. It is possible to assign a value right at the declaration or after. The

D
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value of a variable can be modified infinite times. If you put quotes(simple or double) around
the value of a variable it will be a string, if numbers are used only, it will be a number. If
letters are used without quotes, it will be interpreted as a variable, throwing an error if it
doesn’t exist. Types of variables are dynamic, assigning text to a number variable will make
it a string variable. Another important type is the boolean. It has two values: true and
false.
Example:
/ / D e c l a r a t i o n o f a s i n g l e number v a r i a b l e :

var a;
/ / D e c l a r a t i o n o f s e v e r a l v a r i a b l e s w i t h and w i t h o u t v a l u e :

var a = 5, b = " something ", c, d = false;
c = a + 5;
a = b;

Please Note: redeclaration of a variable is possible, if there is no new value, the variable
will remain exactly the same as before.

Operators
Let’s go through operators using an example. The comments next to statements show their
results.
/ / Arithmetic operators :

var a =
c = a +
c = a −
c = a *
c = a /
c = a %
c++; / / c
c −−; / / c

2, b = 3, c;
b; / / c w i l l be
b; / / c w i l l be
b; / / c w i l l be
b; / / c w i l l be
b; / / c w i l l be

5 ( addition )
−1 ( s u b t r a c t i o n )
6 ( multiplication )
0.666 ( d i v i s i o n )
2 ( modulus )
w i l l be 3 ( i n c r e m e n t a t i o n )
w i l l be 2 ( d e c r e m e n t a t i o n )

/ / Assignment o p e r a t o r s :
c = 5; / / c w i l l be 5
c += 2; / / c w i l l be 7 ( e q u a l s t o c = c + 2 )
c −= 3; / / c w i l l be 4 ( e q u a l s t o c = c − 3 )
c * = 3; / / c w i l l be 12 ( e q u a l s t o c = c * 3 )
c /= 4; / / c w i l l be 3 ( e q u a l s t o c = c / 4 )
c %= 2; / / c w i l l be 1 ( e q u a l s t o c = c % 2 )

a = " Hello", b = " FlexGui ", c = 3, d;
d = a + " " + b + c; / / d w i l l be " H e l l o F l e x G u i 3 "
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/ / Comparison o p e r a t o r s :

a
b
b
b
b
b
b
b
b

=
=
=
=
=
=
=
=
=

3, b;
a == 2; / / b w i l l be f a l s e ( e q u a l )
a === "3"; / / b w i l l be f a l s e ( v a l u e and t y p e e q u a l t o o )
a != 2; / / b w i l l be t r u e ( n o t e q u a l )
a !== "2"; / / b w i l l be t r u e ( n o t e q u a l n e i t h e r v a l u e o r t y p e )
a > 2; / / b w i l l be t r u e ( g r e a t e r t h a n )
a < 2; / / b w i l l be f a l s e ( l e s s t h a n )
a >= 2; / / b w i l l be t r u e ( g r e a t e r t h e n o r e q u a l t o )
a <= 2; / / b w i l l be f a l s e ( l e s s t h e n o r e q u a l t o )

/ / Logical operators :

a
c
c
c

=
=
=
=

true , b = false , c;
a && b; / / c w i l l be f a l s e ( and )
a || b; / / c w i l l be t r u e ( o r )
!a; / / c w i l l be f a l s e ( n o t )

/ / Conditional operator :
/ / ( c o n d i t i o n ) ? value1 : value2 ;
var a = 3 > 5 ? 1 : 2; / / a w i l l be 2

Conditional statements
Conditional statements can be used to determine if a code should run or not depending on
a logical statement. Example:

if (4 > 6)
{
var a = 5;
}
else
{
var a = 6;
}

Because the result of 4 > 6 is false, the else part will be executed, a will be 6. It is possible
to use the statement without the else branch.
Please Note: curly brackets are used to group more statements, but not obligatory for one
(if (4 > 6) a = 5; is ok).
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Loops
The for loop
The for loop executes the code block while the middle statement is true. The first statement
is executed before the loop, the last one is executed after each loop.

for (var i = 0; i < 5; i++)
{
/ / Statements

}

The while loop
The while loop executes the code block while the statement is true.

while (i < 5)
{
/ / Statements

}

The do/while loop
The do/while loop executes the code block while the statement is true. The condition is
checked after each run, so the body will be ran at least once.

do
{
/ / Statements

}
while (i < 5)
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Appendix - FlexGui Configuration Entries
Entry
FlexServerPort
FlexServerAddress
NraPort
NraAddress
SharedDir
RobotProgramDir
NraAutoconnect
FullScreen
StartHidden
Locale
PressAndHoldMode
Width

Height

BeltItemHeight
UpdateTarget
ShowUtilityScreen
ShowNewScreen
FlexGuiName
Backups (entryset)

Description
The port of the FlexServer/Toolbox to connect to.
The IP address/hostname of the FlexServer/Toolbox to connect to.
The port where NRA listens.
The IP address where NRA listens.
The directory of where the FlexGui project file is stored.
The directory where the robot programs are stored.
If set to "True" FlexGui will automatically connect to NRA.
If set to "True" FlexGui will run using full screen, if set to
"False" it will run in a window.
If set to "True" FlexGui will start in hidden mode.
Stores the last selected language.
If set to "True" screen changes will need a longer press on
the screen Belt.
The width of the screen. If changed, the FlexGuiRoot directory has to be deleted to start a new project with that screen
size.
The height of the screen. If changed, the FlexGuiRoot directory has to be deleted to start a new project with that screen
size.
The height of the items on the belts.
The target directory of updates, where FlexGui.exe is
stored.
If set to "True" the utility screen is listed on the screen belt.
If set to "True" the new screen is listed on the screen belt if
it is not running in demo mode.
The name of FlexGui that is shown in FlexServer.
Specifies the directories to be included when using the
backup feature..

Table 6: Configuration Entries in FlexGui’s config.ini.
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Entry
NraPort
NraAddress
Locale
RobotProgramDir

PressAndHoldMode
BeltItemHeight
ToolboxName
RemoteViewHost
RemoteViewPort
ShowUtilityScreen
ShowNewScreen
ExplorerAutoRefresh
NRA2011ExePath

FlexGuiAnywherePort
FlexGuiAnywhereLocalOnly

Description
The port where FD on Desk listens.
The IP address where FD on Desk listens.
Stores the last selected language.
Used by the FD on Desk tab in FlexProject Explorer. This
should be configured to point to FDonDesk’s robot program
folder. E.g. c:/FDonDesk/Nra2011/WORK/PROGRAM
Used in preview mode: If set to "True" screen changes will
need a longer press on the screen Belt.
Used in preview mode: The height of the items on the belts.
The name of the Toolbox shown when acting as a remote
FlexServer.
The IP address/hostname of the remote FlexServer/Toolbox
to connect to.
The port of the remote FlexServer/Toolbox to connect to.
Used in preview mode: If set to "True" the utility screen is
listed on the screen belt.
Used in preview mode: If set to "True" the new screen is
listed on the screen belt if it is not running in demo mode.
Stores the last settings used for the Auto Refresh function
of FlexProject Explorer.
Used by the File → Start FD on Desk option. This should
be configured to point to FDonDesk’s NRA execute file. E.g.
c:/FDonDesk/Nra2011/NRA2011.exe
Defines the port used for the FlexGui Anywhere service.
Specifies whether the FlexGui Anywhere can only be used
on the local network or not. If set to False, the FlexGui Anywhere service also accepts requests from outside the local
network.

Table 7: FlexGui Toolbox configuration entries

